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Introduction
Use the following information when you want the Metasys Database Manager to interact with and
monitor the trend, alarm (event), audit, and annotation databases on the following servers:

• Application and Data Server (ADS)
• Extended Application and Data Server (ADX)
• Open Application Server (OAS)

The Metasys Database Manager supports all versions of Microsoft® SQL Server® software.

Note: In this document, ADS/ADX includes the ADS-Lite, unless noted otherwise.

The latest available version of the ODS is Release 10.1. The ODS is not available for upgrade to
Metasys Release 11.0.

You can use the following options to install the Metasys Database Manager:

• Add the Metasys Database Manager to the ADS, ADX, ODS, or OAS computer at any time
before or after the initial ADS, ADX, ODS, or OAS installation.

• Install the Metasys Database Manager on the database server computer of a split ADX.

Important: If you need to perform an out-of place upgrade, see Performing an out-of-place
upgrade.

All versions of the ADS, ADX, ODS, and OAS support the Metasys Database Manager, including
the ADX and ODS that run the Metasys Advanced Reporting System, and the ADXs for Metasys for
Validated Environments (MVE), extended architecture. (The ODS or OAS do not support MVE.)

Note: Annotations entered for events and audits are stored in the JCIEvents and JCIAuditTrails
databases. The JCIItemAnnotation database is installed with every ADS/ADX/ODS/OAS and
stores annotations for other system items.

Summary of changes
The following information is new or revised:

• Added support for Windows Server® 2019.
• Removed support for Windows Server ® 2012.
• Removed support for Windows 7®.
• Updated supported operating systems in Required access rights

No additional technical changes were made to the document for this release.

Metasys Database Manager overview
The Metasys Database Manager provides both Managing databases and Monitoring databases
functions, which are handled in two separate windows.
On a unified ADS/ADX/ODS/OAS computer, the default path of the Metasys Database Manager
is C:\Program Files (x86)\Johnson Controls. If you have a split ADX, you must install
the Metasys Database Manager on the database server computer. Refer to the Metasys Database
Manager Installation Guide (LIT-12011553) for details on installation.
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 Database Management
The ADS/ADX and OAS Metasys servers include trend, alarm (event), audit, annotation, and
reporting databases. The Metasys system also provides summarized information about these
databases and database operations. Database Manager lets you back up, purge, restore, and
rename field contents in the various databases.
Three new SQL databases: MetasysValue, MetasysFault, and MetasysFaultTriage have
been introduced at Metasys Release 11.0. To activate the databases, license the associated
Metasys features, these include, potential problem areas, fault detection, and fault triage. The
MetasysValueand MetasysFault databases self-maintain and store a rolling seven days’ worth of
data. These databases are not monitored or managed by Metasys Database Manager.

Note: The Restore and Rename functions are available in Expert Mode only. See Expert mode.

Figure 1: Managing Window

 Database Monitoring
The monitoring feature continually reads database information and provides alerts on the taskbar,
by email, or using both methods, based on user-configurable warning and alarm levels.
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Figure 2: Monitoring Window

For more information about the Metasys
Database Manager, see these sections:

To start using the Metasys Database Manager,
see these sections:

Required access rights Checking database statistics

Taskbar icon Backing up a database

Status bar Purging a database

Tabs Restoring a database

Expert mode Renaming field contents in Metasys databases

Monitoring settings Managing databases

Split ADX considerations Accessing/Starting monitoring settings

Interaction with the Metasys system Choosing monitoring settings

Settings.xml Stopping database monitoring

Log file Viewing the log file

7Metasys Database Manager Help



Required access rights
The content that you can view and the steps that you can perform in the Metasys Database Manager
depend on your Microsoft Windows® access rights and on the Microsoft SQL Server privileges
assigned to your Windows login.
Table 1: Windows Access Rights

Operating System
Operating
System
Access Rights

Corresponding
SQL Server
Access Rights (If
Using Windows
Authentication
to Access SQL)

Functionality

Administrator System
Administrator

You are able to see and do
everything in the Metasys Database
Manager.

Public User

You can view only the Statistics
tab, you cannot use Expert Mode,
and you cannot access the Settings
window.

Member of
Administrator
Group

System
Administrator

You are able to see and do
everything in the Metasys Database
Manager.

Windows® 10 Pro and
Windows 10 Enterprise
Editions versions 1903,
1909, and 2004 (64-
bit). For all future
Windows 10 updates
after version 2004,
we will evaluate and
certify that Metasys
software can support
the updates before we
provide guidance on
support.

Windows® 8.1
Pro and Windows
8.1 Enterprise
Editions with Update
(KB2919355) (64-bit)

Windows® Server®
2016 with Update
(KB4512495) (64-bit)

Windows® Server®
2019 (version 1903)
(64-bit)

Standard User Public User

You can view only the Statistics
tab, you cannot use Expert Mode,
and you cannot access the Settings
window.

Note: To allow a member of the OS Administrator group to function as a SQL Server System
Administrator, you must take special steps. For database management using Metasys Database
Manager, you must click Yes in the User Account Control window that appears when you
attempt to open the Metasys Database Manager. See Opening the Metasys database manager to
manage your databases. To view and change database monitoring settings in Metasys Database
Manager, close the Metasys Database Monitor, right-click Metasys Database Monitor from the
Start menu, select Run as Administrator, and click Yes in the User Account Control window. See
Accessing/Starting monitoring settings. The Detailed procedures section mentions these special
steps when needed.)
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Taskbar icon

The taskbar icon (  or  or ) represents the status of your databases graphically and allows
you to access the Metasys Database Manager and its monitoring settings. When the icon is present,
regardless of color, the Metasys Database Manager is actively monitoring your databases.

• Icon colors

• Icon right-click menu

• Opening the Metasys database manager to manage your databases

• Accessing/Starting monitoring settings

Icon colors
The Metasys Database Manager taskbar icon changes color and size to alert you if a database
exceeds the limits defined in the monitoring settings (see Choosing monitoring settings). When you
click the icon, a balloon offers more details on the status of the databases.
The icon represents three states:

Normal 

A small green database icon appears when all databases are within their limits. When you click the
icon, a balloon displays the following text:
Status: Normal

All Metasys Databases are within acceptable file size limits.

When you click the balloon, the Statistics tab of the Metasys Database Manager appears.

Warning 

A medium-sized yellow database icon appears when one or more databases exceed their warning
limits. When you click the icon, a balloon displays the following text:
Status: Warning

The following Databases are past their warning limits: DatabaseName

When you click the balloon, the Maintenance tab of the Metasys Database Manager appears so that
you can maintain the database.
To define the Warning settings, see Choosing monitoring settings.

Alarm 

A large red database icon appears when:

• One or more databases exceed their alarm limits.
• The Metasys Database Manager cannot connect with the SQL Server database.
• The Metasys Database Manager is installed before the ADS/ADX/ODS/OAS and no historical

databases are present. In this situation, the Metasys Database Manager opens in Expert Mode,
showing the Restore tab so that you can restore the databases. See Expert mode.

Note: The latest available version of the ODS is Release 10.1. The ODS is not available for
upgrade to Metasys Release 11.

When you click the icon, a balloon displays the following text:
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Status: Alarm

The following databases need to be maintained: DatabaseName

When you click the balloon, the Maintenance stab of the Metasys Database Manager appears so
that you can maintain the database.
To define the Alarm settings, see Choosing monitoring settings.

Icon right-click menu
The Metasys Database Manager icon right-click menu allows you to access the Metasys Database
Manager and its monitoring settings (Table 2).
Table 2: Taskbar Icon Menu
Selection Description
Open Opens the Metasys Database Manager. See Managing databases.

Settings Displays the Settings window where you can view and modify the monitoring
parameters. See Monitoring databases.

View Log File Launches the Windows Event Viewer. See Log file.
Help Opens the Metasys Database Manager Help.
About Displays version information.

Exit Stops all database monitoring and removes the taskbar icon. To start
monitoring again and restore the icon, see Monitoring databases.

Status bar
The status bar provides information on the current activity of the Metasys Database Manager and is
visible at the bottom of all tabs (Figure 3). The status bar is not present on the Monitoring Settings
window.

Figure 3: Status Bar
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Table 3: Status Bar Components
Callout Part Description

1 Icon

Displays an icon that depicts the status of a Metasys Database Manager
action:

 - ready

 - purging records from a database

 - action failed

 - refreshing statistics

 - restoring a database

 - shrinking a database and shrinking database files

 - backing up a database

 - resetting Internet Information Services (IIS)

 - starting the Metasys Device Manager

Note: During some maintenance operations, the Metasys Device
Manager shuts down to avoid possible database read/write conflicts.
This process restarts the Metasys Device Manager so that the Metasys
user interface is once again available to users.

 - shutting down the Metasys Device Manager

Note: During some maintenance operations, the Metasys Device
Manager shuts down to avoid possible database read/write conflicts.
The Metasys user interface is unavailable to users during this time.

 - action successful

2 Text

Includes text that describes the action currently taking place. If the
Metasys Database Manager is not currently performing a task, this part
of the status bar shows when the data was gathered from the database
(when the snapshot was taken).

3 Additional
Text

Provides additional status description text. For example, when purging
records, this part of the status bar displays the number of records
deleted from the total number of records.
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Tabs
The Metasys Database Manager contains a Status bar and five tabs (Figure 4). Click one of the
following links to learn more about the contents of that tab.

• Statistics tab

• Maintenance tab

• Backup tab

• Restore tab

• Rename tab

Figure 4: Tabs in the Metasys Database Manager

Note: The Restore tab and the Rename tab are available in Expert Mode only. See Expert mode.

Statistics tab
The Statistics tab contains information about the SQL Server software loaded on the Metasys ADS/
ADX/ODS/OAS computer and displays database information for each of the trend, alarm (event),
audit, annotation, and reporting databases.

Note: The latest available version of the ODS is Release 10.1. The ODS is not available for
upgrade to Metasys Release 11.

The Statistics tab is divided into two sections (Figure 5):

• Database server

• Metasys databases

See Status bar for information on the status bar.
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Figure 5: Statistics Tab

Database server
The Database Server section displays information on the SQL Server software. See Table 4.
Table 4: Database Server Section Contents
Field Description
Server Name Displays the name of the local running SQL Server software.

Current Database Server
Connections

Displays the number of connections to SQL Server software at
the time you launch the Metasys Database Manager. If the value
of this field is 0, you are using the Metasys Database Manager in
a limited capacity (read-only) because the user running the tool
is not a SQL Server database administrator.

This value is not refreshed.

Database Server Type
Displays the type of SQL Server software that has been installed.

For example, this field may contain Express Edition.

Metasys databases
The Metasys Databases section contains statistical information about the trend, alarm (event),
audit, and annotation databases (Table 5). The SQL Server software directly supplies all of the
information on the tab. For more information on the fields in the tab, refer to your SQL Server
software documentation.
Table 5: Metasys Databases Section Fields
Field Description
Database Name The SQL Server software database name.

Database Path The system path where the database exists. When you place your
cursor over the path, the entire path appears in a tooltip.

Backup Database Path The current directory where database backups are created. When you
place your cursor over the path, the entire path appears in a tooltip.
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Table 5: Metasys Databases Section Fields
Field Description

Database Size
The physical size of the data (and only the data) inside the database.
For the size of the file that contains the database, see Database Data
File Size.

Database Index Size The physical size of the index for the database.

Database Reserved Space
The physical size of space in the .mdf and .ldf file reserved for future
use by objects within the database. This typically is space assigned to
individual tables and indexes and log buffer space.

Database Unallocated
Space

The physical size of space in the database .mdf and .ldf files that
has not been reserved for use by objects within the database. The
database can use this space to grow tables or logs without growing
the physical file size on the hard disk.

Database Data File Size*

The size of the data file for the database (.mdf file) that takes up room
on the computer. The Metasys Database Manager uses this value
and the value in Database Log File Size to calculate the % Full for the
database.

Database Log File Size*

The size of the log file for the database (.ldf file) that takes up room
on the computer. The Metasys Database Manager uses this value
and the value in Database Log File Size to calculate the % Full for the
database.

Database File Size*

The physical space taken up by the entire database. The entire
database includes *.mdf and .ldf files. The size of the .mdf file
is indicated in Database Data File Size. The size of the .ldf file is
indicated in Database Log File Size.

Maximum Database File
Size*

The size of the database, depending on the server type:

• Express Edition: The maximum size is 10 GB (SQL Server 2019
Express, SQL Server 2017 Express with CU17, or SQL Server 2016
Express SP2 CU10)

• All others: The maximum size is half the physical size of the free
disk space for the location of the database minus the size in
the Database File Size field. Half the free space is required for a
backup; therefore, the database can only take up half the free
space.

% Full* The percent of the maximum database file size that the database
currently uses.

Note: The background of these attributes marked with an asterisk change color when they
exceed the warning or alarm limits defined in Choosing Monitoring Settings. The attributes in
Figure 5 are within their limits. However, a yellow background indicates that the warning limit
has been exceeded, and a red background indicates that the alarm limit has been exceeded or
that the Database Manager cannot connect to the SQL Server database.

Maintenance tab
The Maintenance tab provides an easy way to purge records from the trend, alarm (event), audit,
and annotation databases. Figure 6 shows the Maintenance tab. (If you cannot see this tab, see
Required access rights.)
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Note: We recommend that you purge records before you rename field contents. Doing so will
speed the renaming process. See Renaming field contents in Metasys databases.

See Interaction with the Metasys system for information on ADS/ADX/ODS/OAS disruption during
database maintenance.

Note: The latest available version of the ODS is Release 10.1. The ODS is not available for
upgrade to Metasys Release 11.

The Maintenance tab is divided into three sections (Figure 6):

• Maintenance type

• Maintenance thresholds

• Database selection

See Status bar for information on the status bar.

Figure 6: Maintenance Tab

You can back up a database before you purge it. Backing up a database ensures that you can
restore purged data, if necessary. See Backing up a database.

Maintenance type
The Maintenance Type section allows you to create a backup prior to maintenance (Table 6).
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Table 6: Maintenance Type Selections
Selection Description

Manual

Requires you to choose a threshold (see Maintenance thresholds), choose
databases (see Database selection), and click Purge Data Now to purge
the database.

Note: Currently, this is the only option available to maintain your
databases. It cannot be deselected.

Create Backup Prior
to Maintenance?

When selected, creates a backup file before data is purged from the
databases.

Note: The backup fails if there is not sufficient disk space at the backup
destination.

Maintenance thresholds
Use the maintenance thresholds section to purge the databases while retaining a set number of
days' worth of data. Select the number of days' worth of data you want to retain. Choose from the
following options:

• No data (No)
• Current Month's data
• Last Month's data
• Last 2 Month's data
• Last 3 Month's data
• Last 6 Month's data
• Last 12 Month's data
• Last 24 Month's data
• Last 36 Month's data
• Last 60 Month's data
• Custom Cutoff Date

If you want to delete all records, choose No.

Database selection
The Database Selection section allows you to choose which of the following databases you want to
purge:

• JCIHistorianDB - trends
• JCIEvents - alarms (events)
• JCIAuditTrails - audits
• JCIItemAnnotation - annotations
• JCIReportingDB - Metasys UI Reporting

Note:

• The JCIHistorian database also contains information for Energy Essentials. This database
contains some aggregated consumption data that may be used for Energy Essentials
reports.
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• MetasysReporting does not appear on this list because it is self-maintaining.

The background of the database name changes color if the database has exceeded the warning or
alarm limits defined in the Choosing monitoring settings. A yellow background indicates that the
warning limit has been exceeded, and a red background indicates that the alarm limit has been
exceeded or that the Metasys Database Manager cannot connect to the SQL Server database.
This section also contains the Purge Data Now button that triggers the purge. You must make
selections in the Backup file path and Database selection sections and select a database to purge
before you click Purge Data Now.

Backup tab
The Backup tab allows you to create a SQL Server software backup of a database. (If you cannot see
this tab, see Required access rights.)
The Backup tab is divided into two sections (Figure 7):

• Backup file path

• Database selection

See Status bar for information on the status bar.

Figure 7: Backup Tab

Backup file path
The Backup File Path field shows the path where the backup is created. By default, backups are
created in the same directory as the database files.
The Metasys Database Manager may not be able to restore your databases from all file locations.
Therefore, we recommend that you use the default path C:\ProgramData\JohnsonControls
\MetasysIII\SQLData.
Click the Browse button to navigate to a new location for the backup databases, but we
recommend that you keep the default path C:\ProgramData\Johnson Controls\MetasysIII
\SQLData. See Table 7 for details on file saving choices.
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Table 7: File Saving Choices
Selection Description

Create New File

Creates a new backup file with today's date as part of the file name. If a file
already exists with the same name and same date, it is overwritten. Only
the most recent backup file is retained for any day. The backup file is named
YYMMDD<DB Name>.bak, where:

• YY - year
• MM - month
• DD - day
• <DB Name> - the name of the database

For example: 140807JCIAuditTrails.bak.

You can have several files with different dates saved in the same location.

Overwrite File

Overwrites an existing backup with the same name. Only the most recent backup
file is retained. The backup is named <DB Name>.bak.

You can only have a single file with this name saved in a location.

Database selection
The Database Selection section allows you to choose which of the following databases you want to
back up:

• JCIHistorianDB - trends
• JCIEvents - alarms (events)
• JCIAuditTrails - audits
• JCIItemAnnotation - annotations
• MetasysReporting - Metasys Advanced Reporting System
• JCIReportingDB - Metasys UI Reporting
• Spaces Authorization - permissions

Note: MetasysReporting and JCIReportingDB appear in the list if the databases exists.

Clicking the Backup button begins backing up the selected databases immediately. The backup
is a full SQL Server database backup and is performed without needing to shut down the Metasys
Device Manager.

Note:  The backup fails if there is not enough disk space for the backup file.

If you select the Rebuild Indexes during backup process check box, SQL Server software rebuilds
the database indexes during the backup. The operation may slow down the backup process, but it
may speed up database access later.

Note:

• Re-indexing your database temporarily increases your database size (up to twice its original
size). Make sure that you have enough hard disk space when you select this option.

• SQL Server software index rebuilding is a normal SQL Server software database
maintenance operation that should be done weekly or monthly depending on data change
volume. Refer to the SQL Server software documentation for details on the index rebuilding
procedure.
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• You cannot back up the JCIItemAnnotation database in Releases 2.2, 3.0, and 3.1.

Expert mode
Expert Mode lets you view two additional tabs:

• Restore tab

• Rename tab

To access Expert Mode, browse to C:\Program Files (x86)\Johnson Controls\Metasys
Database Manager (Figure 8). Double-click Expert Mode in the Metasys Database Manager file.

Figure 8: Expert Mode

If you are performing an out-of-place upgrade, use Expert Mode to restore databases and rename
database field contents.

Note: Expert Mode functionality does not remain if you close the window and then start the
Metasys Database Manager in standard mode.

Restore tab
The Restore tab is available only when you are using the Metasys Database Manager in Expert
Mode. (If you cannot see this tab, see Required access rights.)
If you are performing an out-of-place upgrade, use the Restore tab to restore historical databases.
The Restore tab also provides a simple way to recover if your Metasys system database becomes
corrupted. Perform a restore only if there is no alternative, and use the most recent successful
backup file.

Important:

Restoring a database deletes any information that is in the database from the time the backup
was created to when it was restored. Use this option to restore a database during an out-of-
place upgrade, or to repair a corrupted database only. This feature should not be used to view
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historical data in the Metasys system. Instead, use the Metasys Export Utility to store and view
historical data in more user-friendly formats.

You cannot restore database backups from a newer version of SQL Server software to an older
version of SQL Server software. For example, you cannot create a backup of Metasys databases
that are hosted on SQL Server 2019 software and restore them to SQL Server 2016 software.
However, you can restore database backups from an older version of SQL Server to a newer
version of SQL Server. If you restore a database that was created using a version of SQL Server
software that is older than the version you are currently using, the Metasys Database Manager
upgrades the database so it can function with the current SQL Server software version.

If you restore a database from a release of Metasys software that is earlier than the software
that you are using, the ADS/ADX/ODS/OAS stops functioning. No fail-safes prevent you from
restoring a database that is older than the database you are using. Be sure to restore databases
from the same release that you are using if the ADS/ADX/ODS/OAS is already installed.
Beginning at Release 5.0, you can restore a Release 2.2 or later database before a Release 5.0
ADS/ADX is installed as part of data preservation during the upgrade process. If you are not
performing an out-of-place upgrade as detailed in the Metasys Server Installation and Upgrade
Guide (LIT-12012162) or ODS Installation and Upgrade Guide (LIT-12011945), you cannot restore a
database from a system that does not have the Metasys Advanced Reporting System installed to
a system that does have the reporting system installed. The database does not contain all the
stored procedures required to use the reporting system. If you attempt to do this, the reporting
system does not function.

Note: The latest available version of the ODS is Release 10.1. The ODS is not available for
upgrade to Metasys Release 11.

Do not restore databases from a different server unless you follow the process for performing
an out-of-place upgrade as detailed in the Metasys Server Installation and Upgrade Guide
(LIT-12012162) or ODS Installation and Upgrade Guide (LIT-12011945). Even if both systems have
the same name and are at the same Metasys release, there are underlying differences in the
databases.

See Interaction with the Metasys system for information on ADS/ADX/ODS/OAS behavior during
database restoration.
The Restore tab opens with a warning that offers the choice whether to continue with or cancel the
restore. Clicking Continue proceeds with the restore and Figure 9 appears.

Figure 9: Restore Tab
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The Backup File field allows you to browse to the database you want to restore to the ADS/ADX/
ODS/OAS. Once a backup file is selected, clicking Restore Now starts the database restore. See
Restoring a database.

Rename tab
The Rename tab is available only when you are using the Metasys Database Manager in Expert
Mode. (If you cannot see this tab, see Required access rights.)
If the ADS/ADX/ODS/OAS computer is renamed in the SCT, use the rename function in Metasys
Database Manager to replace the old Site Director name or an old device name in the JCI databases
with a new name. For more information on renaming a computer in SCT, refer to the Metasys SCT
Help (LIT-12011964).
The Rename tab is divided into two sections (Figure 10):

• Update databases

• Backup file path

See Status bar for information on the status bar.

Figure 10: Rename Tab

Update databases
The Update Databases section shows the databases that are searched during the rename process:

• JCIHistorianDB - trends
• JCIEvents - alarms (events)
• JCIAuditTrails - audits
• JCIItemAnnotation - annotations
• MetasysReporting - Metasys Advanced Reporting System
• JCIReportingDB - Metasys UI Reporting
• Spaces Authorization - permissions

Note: MetasysReporting and JCIReportingDB appear in the list if the databases exist.
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This section has Old and New fields where you type the old name and the new name of the Site
Director or device. Clicking the Rename Now button starts the find/replace process of the field
contents in the Metasys databases.

Backup file path
If you select the Create Backup check box, the databases are backed up before the rename
process begins.
The Backup File Path field shows the location where the backup file is saved. By default, backups
are created in the same directory as the database files.
Click the Browse button to navigate to a new location for the backup files, but we recommend that
you keep the default path C:\ProgramData\Johnson Controls\MetasysIII\SQLData.

Monitoring settings
The monitoring capabilities of Metasys Database Manager let you set the file size limit (percentage
full) that determines the database status. Database statuses are Normal, Warning, and Alarm.
Monitoring settings appear in a different window from the tabbed window described in Tabs.
When you log in to the Windows OS on an ADS/ADX/ODS/OAS computer, the monitoring starts
automatically. Monitoring does not stop unless you exit monitoring or log out of the Windows OS
on the ADS/ADX/ODS/OAS computer. If you exit and want to restart monitoring, you must either
log in to the Windows OS on the ADS/ADX/ODS/OAS, or restart the monitoring itself. See Stopping
database monitoring and Accessing/Starting monitoring settings for information.

Note: The latest available version of the ODS is Release 10.1. The ODS is not available for
upgrade to Metasys Release 11.

Note: If you have administrator privileges, the Metasys Database Manager Monitoring Settings
window appears each time you restart your computer (unless you have already configured
it for monitoring). See Choosing monitoring settings. To access the setting for other users
who have administrator privileges, close the Metasys Database Manager Monitor and log in as
Administrator. See Accessing/Starting monitoring settings.

The Metasys Database Manager Monitoring Settings window is divided into five sections (Figure 11):

• General

• Email

• Warning

• Alarm

• Database login
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Figure 11: Monitoring Settings Window

General
The General section contains the main settings for monitoring databases as shown in the following
table.
Table 8: General Section Contents
Field Description

Scan Interval

The frequency with which the databases are checked against their limits.
Options are:

• Every half hour
• Every hour
• Every 8 hours
• Every day

Start Time
The hour and minute that the check on the databases first occurs

Note: For scan intervals of every half hour and every hour, the hour
selection is disabled because it is not applicable.
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By default, the Metasys Database Manager Monitor checks the databases every hour on the 53rd
minute so it does not interfere with the default ADS Delivery Time of 12:15 A.M. (ADS Delivery Time
is the name of the parameter for both an ADS and an ODS.)

Email
The email feature is optional for Metasys servers. It requires a valid SMTP email account and access
to the SMTP server. For email functionality to work, you must enter at least one valid entry for
SMTP server (outgoing), Email address (From), and Email address (To/CC/BCC) as shown in the
following table.

Note: The latest available version of the ODS is Release 10.1. The ODS is not available for
upgrade to Metasys Release 11.

Table 9: Email Section Contents
Field Description

SMTP Server
(outgoing)

Enter either the IP address or the name of the SMTP server. We recommend
using the IP address because it does not rely on the domain name system
(DNS) to resolve the name.

Example: 167.206.112.6 (mail-hub.optonline.net)

To avoid having the Monitoring Settings window appear when you restart
the ADS/ADX/ODS/OAS, enter the SMTP server in this field.

Note: If you do not know the SMTP server address or name, contact your
IT department.

Email Address
(From)

Enter the email address from which the Metasys Database Manager Monitor
email is sent. Metasys Database Manager is used as an alias for email
clients that support it.

Email Addresses (To)
Click the Browse button to display the Address List window, see Figure 12.
Enter either email addresses, or cell phone numbers for text messages in
the fields provided. Email addresses appear in the To: field of the email.

Email Addresses (CC)

Click the Browse button to display the Address List window, see Figure 12.
Enter either email addresses, or cell phone numbers for text messages in
the fields provided. Email addresses appear in the CC (carbon copy) field of
the email.

Email Addresses
(BCC)

Click the Browse button to display the Address List window, see Figure 12.
Enter either email addresses, or cell phone numbers for text messages in
the fields provided. Email addresses appear in the BCC (blind carbon copy)
field of the email.

Email Subject Enter the subject of the email. By default, the subject is Metasys Database
Manager Alert!

Send Test Email Click this button to test the email functionality based on the information
you entered in the fields in the Email section.
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Figure 12: Address List Window

The following table describes the contents of the Address List window.
Table 10: Address List Window Contents
Field Description

Email Address
Enter an email address and click Add to include it in your list. The Metasys
Database Manager checks for proper syntax and returns an error if the
address is invalid.

Phone Number Enter the 10-digit phone number for the cell phone you want to text
message. Do not enter hyphens (-).

Carrier Select from a list of cell phone carriers.

Warning
Use the Warning section to define the warning limit parameters as shown in the following table.
Table 11: Warning Section Contents
Field Description

Warning File Size Limit Choose the percentage of the maximum file size that the database
file must reach before a warning appears.

Show Warning Reminder
every

Select this check box to show a warning balloon when a database
size exceeds the value in Warning File Size Limit.

Choose how often you want to show the balloon. By default, every
24th interval is selected, which shows the warning balloon once a
day until the database has been reduced to an acceptable level.

Email on Warning
Select this check box to enable the email feature of the Metasys
Database Manager Monitor. Only one email is sent when the
database exceeds its warning limits.

Alarm
Use the Alarm section to define the alarm limit parameters as shown in the following table.
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Table 12: Alarm Section Contents
Field Description

Maximum File Size Limit Choose the percentage of the maximum file size that the database file
must reach before an alarm appears.

Show Alarm Reminder
Every

Select the check box to show an alarm balloon when a database size
exceeds the value in Maximum File Size Limit.

Choose how often you want to show the balloon. By default, every
interval is selected, which shows the alarm balloon once a day until
the database has been reduced to an acceptable level.

Email on Alarm
Select this check box to enable the email feature of the Metasys
Database Manager Monitor. Only one email is sent when the database
exceeds its alarm limits.

Database login
If you leave the fields in the Database Login section blank, the Metasys Database Manager uses the
credentials of the user logged in to the Windows OS to access the SQL Server database.
If you enter text into the Database User Account and Password fields, the Metasys Database
Manager uses that set of credentials to access the SQL Server database.
To ensure full access to Metasys Database Manager functionality:

• The credentials that you enter must belong to a SQL Server System Administrator (sysadmin).
• Your Windows login must be that of the administrator or a member of the Administrator

group. Standard Windows users cannot back up and restore or change monitoring settings,
even if they enter SQL Server sysadmin credentials here. However, Standard users can still view
statistics.

See Required access rights for more information.

Split ADX considerations
If you use Metasys Database Manager to manage Metasys databases on a split server, you must
install it on the database server. If a database administrator manages the Metasys databases, then
the Metasys Database Manager installation is optional.

Note: The Metasys Database Manager will not work on the application server.

Refer to the Metasys Database Manager Installation Guide (LIT-12011553) for details on installation.

Settings.xml
The Settings.xml file stores settings from both the Metasys Database Manager and the Metasys
Database Manager Monitor. The file is stored in the XML directory in the Metasys Database Manager
home directory. This file is necessary for proper operation of both applications and should not be
moved or removed. We recommend that most users avoid editing the Settings.xml file.

Log file
Log information is stored in the Windows Event Viewer and can be accessed by right-clicking the
Taskbar Icon and then clicking View Log File. In Event Viewer, click MetasysDBMonitor in the left
pane.
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Detailed procedures
Procedures are described in two sections: Managing databases and Monitoring databases.

To manage databases, see these sections: To monitor databases, see these
sections:

Opening the Metasys database manager to manage your
databases

Checking database statistics

Backing up a database

Purging a database

Restoring a database

Renaming field contents in Metasys databases

Accessing/Starting monitoring
settings

Choosing monitoring settings

Stopping database monitoring

Interaction with the Metasys system
About this task:
The maintenance, restore, and rename functions shut down the Metasys Device Manager, which
disrupts communications for anyone logged in to the Metasys Site Management Portal (SMP)
UI. (Backups do not require shutting down the Metasys Device Manager. Therefore, the backup
function does not interrupt access.)
The following is expected behavior when a user is logged in to the SMP and you maintain, restore,
or rename databases by using the Metasys Database Manager:

1. Users who are accessing the Metasys system server see blue Xs next to all objects in the
navigation tree (Figure 13).

Figure 13: Blue Xs in SMP UI

2. The Metasys system terminates the session and displays the login screen.
3. After the maintenance, restore, and rename functions have finished, users can log in to the

SMP UI again.
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At Release 3.1 and later, the Metasys Database Manager on a unified ADX with the Simple
Recovery model no longer shuts down the Metasys system for the entire time that it
takes to purge records. The Metasys system shuts down only long enough to clean up the
database.

Renaming a computer after an operating system upgrade
using the Metasys rename assistant
To ensure that your upgraded site continues to access historical data, complete the following steps:

1. Use the SCT to rename the Site Director to match the new computer name.
2. Use the Metasys Database Manager to update the Site Director and the device name in the JCI

databases.

For more information about an out-of-place upgrade, see Performing an out-of-place upgrade.
To access the Metasys Rename Assistant, browse to C:\Program Files (x86)\Johnson
Controls\Metasys Database Manager. Double-click Metasys Rename Assistant in the Metasys
Database Manager folder.

Note: If you have large historical databases, the rename procedure may take several hours
to complete. We recommend you purge your databases in advance in order to speed up the
rename process. For more information, see Purging a database.

The latest available version of the ODS is Release 10.1. The ODS is not available for upgrade to
Metasys Release 11.0.

Getting started
During the rename process, Metasys software may be uninstalled and reinstalled; refer to the
installation documents when necessary. Installation documents that may be required are:

• Metasys Server Installation and Upgrade Guide (LIT-12012162)
• Energy Essentials Installation Instructions (LIT-12011539)
• SCT Installation and Upgrade Instructions (LIT-12012067)

1. Once you have read the IMPORTANT notice on the screen, select the checkbox.
2. Select the Enable SQL Server Authentication checkbox.
3. Type your user name and password into the correct boxes.
4. Click Test Connection.

Note:

- If the connection is successful, Connection: Success appears underneath the Test
Connection button and a check appears to the right of the button. If the connection
fails, Connection: Error appears underneath the Test Connection button and an
x appears to the right of the button.

- You cannot proceed if the Test Connection was not successful.

5. Click Get Started.
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Preparing the computer

1. Click Backup to open the Metasys Database Manager to back up your databases. The Metasys
Database Manager window opens.

a. Select the Backup tab.
b. Take note of the backup file path.
c. Under Database Selection, choose which database(s) that you would like to back up.
d. Click Back Up Now to back up the selected database(s).
e. Once backup is complete, close Metasys Database Manager window.

2. Select the checkbox that denotes you have performed the Metasys database backup in the
Metasys Rename Assistant window.

3. Verify the time zone and time for the computer are correct, and select the checkbox denoting
the Time Zone and Time are correct.

Note:  If the time zone and time are not both correct, click the refresh button to update
them.

4. After you have backed up the databases and corrected the time zone and time, the rename
box unlocks. Enter the new name that you want to assign to the ADS/ADX and click Validate
Name.

Note:

- The Name field is case sensitive.
- The new name must be different from the original name.

5. Click Continue.

Note:  A checkmark icon next to each step indicates the step is complete.

Preparing the archive database

1. Click Launch SCT in the Metasys Rename Assistant. The Metasys Launcher opens.
2. Log in to SCT.

Note:  To create a new archive, continue with Step 2. To use an archive that already exists,
skip to Step 8.

3. Click Next. Select the Item menu, then select New Archive. The New Archive wizard opens.
4. Click Next in the Metasys Rename Assistant. Enter a unique name for the new archive in the

box.

Note: When you are asked to close the current archive, click Yes.

5. Click Next in the Metasys Rename Assistant.

a. Click Create.
b. The Create Site window opens. Click Yes. The Insert Site Wizard opens.
c. On the Destination window, select the parent item for the new item. Click Next.
d. On the Identifier window, enter a unique name for the server. Click Next.
e. On the Configure window, click Next.
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Note: The order of the time zones in the Metasys software does not match the order
that they are presented in in the Windows operating system. Use care to select the
correct time zone from the list.

6. Click Next in the Metasys Rename Assistant. On the Summary window, click Finish. The Create
Device? window opens.

7. Click Next in the Metasys Rename Assistant. In the drop-down of the Create Device? window,
select Metasys Server. Click OK. The Insert Metasys Server Wizard opens.

8. Click Next in the Metasys Rename Assistant.

a. On the Object Type window, select the type of object that you wish to create.
b. Click Next.
c. On the Destination window, select the parent item for the new item.
d. Click Next.

Note:  If you select an item that will not work, an error message will appear.
e. On the Identifier window, enter the original ADS/ADX name that appeared in red text in

the Metasys Rename Assistant. Click Next.

9. Click Next in the Metasys Rename Assistant.

a. On the Configure window, click Next.
b. On the Summary window, click Finish. The Metasys Insert Site wizard closes.
c. In SCT, select the Metasys server in the navigation tree.

10. Click Next in the Metasys Rename Assistant. Select the Tools menu. Select Manage Archive.
The Manage Archive Wizard opens.

11. Click Next in the Metasys Rename Assistant. On the Action screen in the Manage Archive
wizard, under Type, select Upload from Device. Click Next.

12. Click Next in the Metasys Rename Assistant.

a. On the Select Devices window, select the devices you want to upload. Click Next.
b. On the Schedule window, click Next.

13. Click Next in the Metasys Rename Assistant.

a. On the Site Login screen, use the computer's name (the red text on the Metasys Rename
Assistant) as the Username, and the same password you entered to log into SCT as the
password for the engine.

b. Click Test Login.

Note:  The login process must succeed in order to proceed.

14. Click Next.

a. On the Specify Retries window, click Next.
b. On the Repeat Upload window, click Next.
c. On the Summary window, click Finish. The Manage Archive wizard closes. The upload

process begins. Progress is shown on the ActionQ screen in SCT.
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15. Click Next in the Rename Assistant. When the completion status reports OK, right-click the
Metasys server in the navigation tree, click Rename. The Rename box appears.

16. Click Next in the Rename Assistant. In the new name box, enter the new ADS/ADX name
written in red text in the Metasys Rename Assistant.

17. Click Next in the Rename Assistant. Click OK.

Note:

- If you have existing user views, open each user view in Edit mode in the SCT, use the
Find/Replace function to change the name, and save the user view. The Site Director
portion of the reference updates to match the new Site Director name (the name you
just entered in the Rename box).

- Do not download or make other name changes in the SCT.

18. Click Next in the Rename Assistant. Double-click the Metasys site in the navigation tree. The
Metasys site information opens in the display pane in SCT.

19. Click Next in the Rename Assistant. Click Edit in the display pane.
20. Click Next.

a. In the Name and Default ADS Repository attributes enter the name you previously
entered in the Rename box. This name appears in red text in the Metasys Rename
Assistant.

b. Click Save.

21. Click Next in the Rename Assistant. Select Tools > Database > Create Backup. A notice window
opens that denotes the backup is complete.

22. Click Next in the Rename Assistant. Exit SCT.
23. Click Continue in the Metasys Rename Assistant.

Renaming the computer

1. Click Windows Rename in the Metasys Rename Assistant. The System Properties window
opens.

2. Click Next.

a. Select the Computer Name tab.
b. Click Change…. The Computer Name/Domain Changes window opens.

3. Click Next in the Rename Assistant. The Computer name field, enter the new ADS/ADX name.
This is the red text from Rename the Computer tab of the Metasys Rename Assistant.

Note:

- If this computer is a member of a domain, specify the name in the Domain field. If the
computer name includes a DNS suffix, enter the suffix.

- If you join the computer to a domain, the DNS suffix appears automatically. If you join
the computer to a workgroup, the DNS suffix is optional.

4. Click Next in the Metasys Rename Assistant. Click OK.
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5. Click Next in the Metasys Rename Assistant. Click OK in the Computer Name/Domain Changes
Window. The Computer Name/Domain Changes warning window opens.

Note: You must restart your computer to apply these changes.

6. Click Next in the Metasys Rename Assistant. Close all windows.
7. Click Next in the Metasys Rename Assistant. Click OK when you are prompted to restart the

computer. Your computer restarts.

Verifying the SQL server software

1. When the SQL Server is running, click the Reconfigure button. When prompted, click OK in the
Restart Computer Now window.

Note:  When you log back in to Windows, a prompt to allow the Metasys Rename Assistant
access to your computer appears. Click Yes. If you are not prompted, reopen the tool
manually.

2. Click the View button next to Report Server Web Service. The Report Server Web Service
window opens

3. Select the checkbox to the left of Report Server Web Service once you have confirmed that the
Report Server is working.

4. Click the View button next to Report Manager Site Identification URL. The Report Manager Site
Identification URL window appears.

5. Check the box to the left of Report Manager Site Identification URL once you have confirmed
that the Report Server is working.

6. Click Continue.

Reinstalling the Metasys software

1. Click MDM Rename. The Metasys Database Manager Window opens.

a. Click the Rename tab.
b. In the Old box, enter the Old Site Director name. This is found in red text in the pop-up

instructions with the Metasys Rename tool.
c. In the New box enter the old Site Director name, this is found in red text in the pop-up

instructions with the Metasys Rename tool.

Note: Ensure you use the proper name format. Enter the old value in the following
format: SiteDirector:SiteDirector or SiteDirector:Device. Enter the
new value in the following format: NewSiteDirector:NewSiteDirector or
SiteDirector:Device.

d. Click Rename Now.
e. Close the Metasys Database Manager.

2. Click Browse under the Install Metasys SCT. The Browse window opens. Navigate to and select
the SCT installation file. Click Open.

3. Click Install. The Metasys SCT installation window opens.

a. Click Install.
b. Select the server from the Server Name drop-down. Click Install.
c. Click Finish.
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4. Click Browse under the Install Metasys ADS. The Browse window opens. Navigate to and select
the ADS installation file. Click Open.

5. Click Install. The Metasys Server installer opens.

a. Click Install.
b. Select the server from the Server Name drop-down. Click Install.
c. Click Restart Now.

6. Click Browse under the Install Energy Essentials. The Browse window opens. Navigate to and
select the Energy Essentials installation file. Click Open.

7. Click Install. The Energy Essentials Install window opens. Click Install.
8. Click Continue. Restart Computer Now window opens. Click OK.

Downloading the Metasys archive database

1. Click Launch SCT. The Metasys Launcher opens. Select SCT tab. Select Server. Click Launch.
Select the archive you wish to work in.

2. Click Next. Open each user view in Edit mode in the SCT. Use the Find/Replace function to
change the name to the new name. Save the user view. Repeat this for each user view. The Site
Director portion of the reference updates to match the new Site Director name.

3. Click Next. Click the Metasys server in the navigation tree.

Note: It is normal at this time for the site name to be the same as the original ADS/ADX
name. Do not attempt to change the site name at this time.

4. Click Next. Click the Tools menu, then Click Manage Archive. The Manage Archive Wizard
opens.

5. Click Next. On the Action window, in the Type section, Click Download to Device. In the
Options section, select the Include Security checkbox so that the ADX user accounts get
recreated. Click Next.

6. Click Next in the Metasys Rename Assistant.

a. On the Select Devices window, select the devices to download.
b. Click Next.
c. On the Schedule window, if you need to schedule the download for a later time, select

when you would like it to download.
d. Click Next.
e. On the Device Change window, click Next.

Note: Do NOT select Use this option to rename a device through the download
process. Do NOT select Use this option to change a device address during the
download.

7. Click Next.

a. On the Site Login window, click Test Login.
b. Click Next.
c. Click Next.
d. Click Finish.
e. Close SCT.
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Applying the launcher settings

1. On the Desktop, right-click the Metasys SCT shortcut. Select Delete. Repeat this for the
Metasys SMP shortcut.

2. Click Next.
3. Click Launcher.
4. Click Next.

a. On the Launcher screen, click the SMP tab to edit an existing SMP profile.

Note:  If you wish to edit a SCT profile, select the SCT tab instead of SMP.
b. Log in.

5. Click Next.

a. Select the profile whose description you want to edit.
b. Click Edit. The Edit screen appears.

6. Click Next. In the New Description field, type the new name you selected for the device.

Note:  You cannot change the IP address or host name of the device on the Edit screen. To
make that change, delete the device, then add the device again.

7. Click Next. Click Save.
8. Click Next. Recreate shortcuts on the Desktop if desired.
9. Click Continue.

Uploading the Metasys archive database

1. Launch SCT. Log in.
2. Click Next. Click the Metasys server in the navigation tree.
3. Click Next. In the Tools menu, select Manage Archive. The Manage Archive Wizard opens.
4. Click Next. In the Action window, in the Type section, select Upload from Device. Click Next.
5. Click Next. In the Select Devices window, select the Metasys server in the navigation tree.

Click Next.
6. Click Next. In the Schedule window, click Next.
7. Click Next. On the Site Login window, click Test Login. Click Next.
8. Click Next. On the Specify Retries window, click Next.
9. Click Next. On the Repeat Upload window, click Next.
10. Click Next. On the Summary window, click Finish.

Note:  When the upload completion status reports OK, the upload is complete. The site and
server names now match.

11. Click Next. Exit the SCT.
12. Click Continue.

Note:  If you are not using the Metasys Advanced Reporting System, the verification and
rename processes are complete.
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Verifying the Metasys Advanced Reporting System

1. Click Launch ADX. Log in to the ADX.
2. Click Next. Select the Tools menu, the select Metasys Advanced Reporting user interface.
3. Click Next. Log in to the Metasys Advanced Reporting user interface.
4. Click Next. Verify that the user interface appears correctly and that the site and ADX have the

correct name.
5. Click Next. Verify that the navigation tree that appears in the Metasys Advanced Reporting user

interfaces matches that that on the SCT/ADX.
6. Click Next. Select Alarm Definition Report and click Run.
7. Click Next. Verify that the report window appears.

Note:  The content of the window is not important at this time. Simply verify that the
window opens successfully.

8. Click Next. Close the report window.
9. Click Next. Select Event, then select Summary Report. Click Run.
10. Click Next. Verify that the report window appears.

Note:  The content of the window is not important at this time. Simply verify that the
window opens successfully.

11. Click Next. Close the report window.
12. Click Completed. The Metasys Rename Assistant closes.

Applying the ADS/ADX settings

ADS Settings

1. Click Launch ADS/ADX.
2. Click Next. If any user views are open, close them.
3. Click Next. Select the View Menu, then select Extended Labels.
4. Click Next. Double-click the Metasys site in the navigation tree.
5. Click Next. Click Edit in the Display pane.
6. Click Next. In the Name and Default ADS Repository attributes, enter the new server name.
7. Click Next.

Note:  The name is case sensitive.

In the Time Zone attribute, set the time zone to the zone written in the Metasys Rename
Assistant.

8. Click Next. Click Save.
9. Click Next. Select Refresh All Tabs from the Action menu.

Note:  The site and ADS/ADX name should now match.

10. Click Next. Exit the ADS/ADX Site Management Portal. The Restart Computer Now window
opens.

11. Click Next. Click OK. The computer restarts.
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Managing databases
To manage a database, use the following procedures:

• Opening the Metasys database manager to manage your databases

• Checking database statistics

• Backing up a database

• Purging a database

• Restoring a database

• Renaming field contents in Metasys databases

Opening the Metasys database manager to manage your databases
You manage the database and monitor the database using different windows.
To open the Metasys Database Manager:

1. Do one of the following:

- On the Start menu, select Programs > Johnson Controls > Metasys Database Manager >
Metasys Database Manager.

- Right-click  or  or  in the taskbar and select Open.
- Double-click Metasys Database Manager icon on the desktop.

2. If the User Account Control window appears, click Yes. If you do not click Yes, only the
Statistics tab is available.
If the User Account Control window does not appear and the Metasys Database Manager
opens with only the Statistics tab available, verify your Windows access rights. See Required
access rights.

Go to Checking database statistics, Purging a database, or Backing up a database.

Checking database statistics
About this task:
Use the Statistics tab to view database statistics.

1. Open the Metasys Database Manager. See Opening the Metasys database manager to
manage your databases.

2. On the Statistics tab, note information about the databases and server.

Backing up a database
About this task:
Use the Backup tab to back up a database. You cannot rename a backup file. However, if you select
create new file when you back up a file, the backup version does not overwrite the previous version
but creates a new file and adds the date to its name.
To best preserve the data during an out-of-place upgrade, back up the databases on the old ADS/
ADX/ODS/OAS immediately before the databases are needed in the new installation.

Note: The latest available version of the ODS is Release 10.1. The ODS is not available for
upgrade to Metasys Release 11.0. .
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To save storage on your computer, delete database back ups from the computer if the database
is no longer required.

You can back up a database before purging it. Backing up a database ensures that you can
restore purged data if necessary. See Purging a database.

If you select create backup prior to maintenance on the maintenance tab, you must fill in the
fields on the backup tab before you purge a database.

The backup tab is not available to all users. Access is dependent on the user's Windows access
rights. See Required access rights.

To back up a database, complete the following steps:

1. Open the Metasys Database Manager. See Opening the Metasys database manager to
manage your databases.

2. Click the Backup tab.
Note: If the Backup tab is not visible, this tab may not be available to you based on your
Windows access rights, or because you did not click Yes in the User Account Control
window. See Required access rights and Opening the Metasys database manager to
manage your databases.

3. In the Backup File Path section, click the Browse button to choose a location for the
database backup files.

Note: The Metasys Database manager may not restore your databases from all file
locations. To avoid any issues, use the default path C:\ProgramData\John Controls
\MetasysIII\SQLData.

4. Click either Create New File or Overwrite File.
5. If you want to rebuild the SQL Server indexes, in the Database Selection section, select the

databases you want to back up, and click Rebuild Indexes during backup process.
6. Click Backup. The Backup in Progress window appears. You can ignore a Not Responding

label that appears in the title bar. The back up is progressing but the page is not refreshing.
Wait until the backup is complete, and the Backup Successful message box appears.

Performing an out-of-place upgrade
If you need to install a new Windows® operating system on the machine currently hosting
the Metasys software, for example Windows 10® instead of Windows 7®, do not complete an
upgrade, instead complete a fresh Windows 10® installation. To ensure that you maintain proper
functionality of the Metasys software family, complete the following steps:

1. Remove the existing self-signed certificate. For more information, refer to the Removing or
rebinding the secure certificate section in the Metasys Server Installation and Upgrade Guide
(LIT-12012162).

2. Back up the Metasys Database Manager, the historical databases, and the ADS, ADX, ODS, or
OAS software, and store them offline.

3. Reformat the machine.
4. Install the software in the following order:

a. Windows® operating system.
b. If applicable, install the System Configuration Tool (SCT).
c. Metasys Database Manager.
d. Restore the historical databases.
e. Install the ADS, ADX, ODS, or OAS software.
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Note: If you need to complete an out-of-place upgrade to a new machine or virtual machine,
follow the same steps but omit Step 3, reformatting the machine.

Purging a database
Use the Maintenance tab to purge databases. The Maintenance tab is not available to all users.
Access is dependent on the user's Windows access rights. See Required access rights.

Important: Unless you back up the database first, the database information cannot be
recovered after you click Purge Data Now.

Note: To minimize Metasys system downtime during a purge, purge the database on a regular
basis. Large databases, for example over 50 GB, may take substantial time to complete the
purge operation.

To purge a database:

1. Open the Metasys Database Manager. See Opening the Metasys database manager to
manage your databases.

2. Click the Maintenance tab.

Note: If the Maintenance tab is not visible, this tab may not be available to you based on your
Windows access rights, or because you did not click Yes in the User Account Control window. See
Required access rights and Opening the Metasys database manager to manage your databases.

3. To create a backup, in the Maintenance Type section, click Create Backup prior to
maintenance.

Note: If you click this box, you must enter information on the Backup tab before you click Purge
Data Now, including the location where the backup files are saved.

4. In the Maintenance Thresholds section, select an amount of data to leave in the database, if
desired. You can leave:

- No data (No)
- Current Month's data
- Last Month's data
- Last 2 Month's data
- Last 3 Month's data
- Last 6 Month's data
- Last 12 Month's data
- Last 24 Month's data
- Last 36 Month's data
- Last 60 Month's data
- Custom Cutoff Date

If you want to delete all records, choose No.

1. In the Database Selection section, select the databases you want to purge.

Note: If you click Create Backup prior to maintenance, you must enter information on the
Backup tab before you click Purge Data Now

2. Click Purge Data Now. An alert message appears (Figure 14).
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Figure 14: Shutdown at the Start of the Purge

3. Click OK to shut down the Metasys system and start the purge.

When the purge is complete, a check mark appears in the status bar (Figure 15).

Figure 15: Successful Purge

Restoring a database

Important: If you perform an out-of-place upgrade, restore the databases and then rename
the device before you install the ADS, ADX, ODS, or OAS software. For more information, see
Renaming field contents in Metasys databases and Introduction.

Note: The latest available version of the ODS is Release 10.1. The ODS is not available for
upgrade to Metasys Release 11.0.

In order to restore databases to the new computer during an out-of-place upgrade, copy the
backup files from the old computer to the same folder on the new computer before proceeding
with the directions in this section.

Note: The Metasys Database Manager may not restore your databases from all file locations.
To avoid any issues, use the default path C:\ProgramData\Johnson Controls\Metasys
\SQLData.

Important:

Restoring a database deletes any information that exists in the database from the time the
backup was created to when it was restored. Use this option to restore a database during an
out-of-place upgrade, or to repair a corrupted database only. This feature should not be used to
view historical data in the Metasys system. Instead, use the Metasys Export Utility for storing and
viewing historical data in more user-friendly formats.

You cannot restore database backups from a newer version of SQL Server software to an older
version of SQL Server software. For example, you cannot create a backup of Metasys databases
that are hosted on SQL Server 2019 software and restore them to SQL Server 2016 software.
However, you can restore database backups from an older version of SQL Server to a newer
version of SQL Server. If you restore a database that was created using a version of SQL Server
software that is older than the version you are currently using, the Metasys Database Manager
upgrades the database so it can function with the current SQL Server software version.

If you restore a database from an earlier release of Metasys software than you are using, the
ADS/ADX/ODS/OAS stops functioning. No fail-safes prevent you from restoring a database that
is older than the database you are using. Be sure to restore databases from the same release
that you are using if the ADS/ADX/ODS/OAS is already installed. Beginning at Release 5.0, you
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can restore a Release 2.2 or later database before a Release 5.0 ADS/ADX is installed as part
of data preservation during the upgrade process. If you are not performing an out-of-place
upgrade as detailed in the Metasys Server Installation and Upgrade Guide (LIT-12012162) or ODS
Installation and Upgrade Guide (LIT-12011945), you cannot restore a database from a system that
does not have the Metasys Advanced Reporting System installed to a system that does have the
reporting system installed. The database does not contain all the stored procedures required to
use the reporting system. If you attempt to do this, the reporting system does not function.

Do not restore databases from a different server unless you follow the process for performing
an out-of-place upgrade as detailed in the Metasys Server Installation and Upgrade Guide
(LIT-12012162) or ODS Installation and Upgrade Guide (LIT-12011945). Even if both systems have
the same name and are at the same Metasys release, there are underlying differences in the
databases.

For more information about the fields on the Restore tab, see Restore tab. The Restore tab is
available in Expert Mode only.
Expert Mode and the Restore tab are not available to all users. Access is dependent on the user's
access rights. See Required access rights.
To restore a database, complete the following steps:

1. Use Windows Explorer to browse to C:\Program Files (x86)\Johnson Controls
\Metasys Database Manager.

2. In the Metasys Database Manager folder, double-click Expert Mode. The Metasys Database
Manager opens in expert mode with the Restore tab enabled.

Note:

If the User Account Control window appears, click Yes.

If the User Account Control window does not appear and the Metasys Database Manager opens
with only the Statistics tab available, verify your Windows access rights. See Required access
rights.

3. Click the Restore tab. A warning appears.
If the Restore tab is not present, see Required access rights.

4. Read the warning and click Continue. The Restore tab appears (Figure 9).
5. To navigate to the database you want to restore, click Browse. For information on specifying

back up file locations, see Backup tab.

Note:

You can restore only one database at a time.
After you select a backup file, a Restore Database File Path field may appear if the following
conditions occur:

- The database name is the name of an existing database.
- The database is trying to replace a database that does not exist; for example, the backup

file name is JCIEvents.bak and the JCIEvents database does not exist in the system.
If prompted to select a Restore Database File Path, select the appropriate file path of the
database.
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Figure 16: Restore Path Dialog Box

6. Click Restore Now. The Restore in Progress window appears. You can ignore a Not
Responding label that appears in the title bar. The restore is progressing but the page
is not refreshing. Wait until the restore is complete, and the Database backup has been
successfully restored message box appears.

Note:

- If you receive an error while restoring a database, you may need to run a SQL script
to fix the problem. Contact the Johnson Controls® Field Support Center (FSC) for
assistance.

- When you restore a database, the Metasys Database Manager creates a backup of
the database before you start the restore and saves it in the same file location as the
database. If you accidentally overwrite a database, see Troubleshooting.

If the security restrictions on your computer prevent you from using Metasys Database Manager to
restore a database you can manually restore databases using Microsoft SQL Management Studio.

Note: This process can ONLY be used to restore backups that were from the same machine
at the same Metasys release. Trying to restore backups from other machines or from previous
versions of Metasys will cause problems.

To restore a database using SQL Management Studio, complete the following steps:

1. Open the Command Prompt in Administrator mode, type net stop miiidm, and press Enter
to stop the Metasys III Device Manager Service.

2. Exit Metasys Database Manager.
3. Open Microsoft SQL Server Management Studio or SQL Server Management Studio

Express, and log in with credentials that have system admin role capabilities.
4. Expand folder to browse to the database you want to restore.
5. Right-click the database name, click Tasks > Restore > Database.
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Figure 17: SQL Server Management Studio Tree

6. In the Restore Database window, in the Source area in the right pane, select Device.
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Figure 18: Restore Database - General Tab

7. To navigate to the database you want to restore, click Browse. For information on specifying
backup file locations, see Backup tab.

Note: The backup file must be in a directory that the SQL Server service account has read
access to.

8. Click OK.
9. Under Select the backupsets to restore,select the check box next to the database you want to

restore.
10. Open the Options tab and click Overwrite the existing database and Close existing

connections to destination database.
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Figure 19: Restore Database - Options Tab

11. Click OK to start the restore.
12. When you are finished restoring your databases, open the Command Prompt, type net start

miiidm, and press Enter to start the Metasys III Device Manager Service.

Renaming field contents in Metasys databases

Important: If you are performing an out-of-place upgrade, restore the databases and then
rename the device before you install the ADS/ADX/ODS/OAS software. See Restoring a
database.

Note: The latest available version of the ODS is Release 10.1. The ODS is not available for
upgrade to Metasys Release 11.

In order for the ADS/ADX/ODS/OAS to continue accessing historical data without interruption,
you should rename the field contents in the JCI databases immediately after you rename the Site
Director in SCT. See Renaming a computer after an operating system upgrade using the Metasys
rename assistant for a complete list of steps to follow in the rename process.
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For more information about the fields on the Rename tab, see Rename tab. The Rename tab is
available in Expert Mode only. Expert Mode and the Rename tab are not available to all users.
Access is dependent on the user's Windows access rights. See Required access rights.
To rename field contents in a Metasys database:

1. Run the historian_query_find_other_site_dirs.sql script that is found in Solutions Database
article 26394 to scan your Historian Database looking for multiple Site Director names. If you
do not have access to the FSC Solutions Database, please contact the FSC for assistance or
execute the Rename procedure and check the log file after the Rename procedure and verify
that there are no errors.

2. If you do have multiple Site Director names in your Historian Database please contact the FSC
to run SQL scripts to resolve the multiple Site Director issue.

3. Using Windows Explorer, browse to C:\Program Files (x86)\Johnson Controls
\Metasys Database Manager.

4. Double-click Expert Mode. The Metasys Database Manager opens in Expert Mode with the
Rename tab enabled.

Note:

If the User Account Control box appears, click Yes.

If you do not click Yes, the Metasys Database Manager opens with only the Statistics tab
available. Verify your Windows access rights. See Required access rights.

5. Click the Rename tab.
6. Do one of the following:

- If you are renaming due to an out-of-place upgrade, deselect Create Backup. (There is no
need to create a backup because you have just restored the original backup.)

- If you are renaming for a reason other than an out-of-place upgrade, click Create Backup
and then click the Browse button in the Backup File Path section to browse to a location for
the database files. We recommend that you use the default path: C:\ProgramData\Johnson
Controls\MetasysIII\SQLData.

7. In the Old field, enter the old name of the Site Director or device. In the New field, enter the
new name of the Site Director or device. Follow the format shown in Table 13.

Table 13: Example Format of Old and New Names
Reference Being
Renamed Old Name New Name

Site Director SiteDirector:SiteDirector NewSiteDirector:NewSiteDirector
Device SiteDirector:Device SiteDirector:NewDevice

Note: The Rename function uses these exact names in the find and replace process. Therefore,
make sure you spell and capitalize the old and new names correctly.

8. Click Rename Now. The status bar displays the status of the rename. When the rename is
complete, a message appears in the status bar (Figure 20).

Note: If a dialog box appears with the message You should stop the Metasys service on the
ADX Application Server before proceeding, click OK to proceed with the rename. This message
is expected when you perform a rename as part of an out-of-place upgrade.

45Metasys Database Manager Help



Figure 20: Successful Rename

9. Open the Microsoft Event Viewer Control Panel > System and Security > Administrative Tools >
Event Viewer.

10. Expand the Applications and Services Logs and select MetasysDBMonitor.
11. Verify that the log file contains no errors. If the error Exception Occurred: Cannot insert

duplicate key row in object 'dbo.tblPoint' with unique index 'IX_tblPoint' appears in the
log file, the rename procedure was not successful and more than one Site Director Name
exists in the database. Please contact the FSC for assistance in solving this issue.

12. Install the ADS/ADX/ODS/OAS software.

Monitoring databases
To monitor a database, use the following procedures:

• Accessing/Starting monitoring settings

• Choosing monitoring settings

• Stopping database monitoring

Accessing/Starting monitoring settings
This procedure starts monitoring if you have stopped it and allows access to the settings while
monitoring is taking place.
To choose Metasys Database Manager monitoring settings:

1. Log in as a user with administrator privileges.
2. If the Settings selection or Monitoring Settings window does not appear, this may be a result

of your Windows access rights (see Required access rights). Do the following:

a. On the Windows Start menu, go to All Programs > Johnson Controls > Metasys Database
Manager.

b. Right-click Metasys Database Monitor and then click Run as Administrator.
If you are not a member of the Administrator group, a credentials box appears.
Enter your credentials.
If you have sufficient privileges, the User Account Control window appears. Click
Yes. The Metasys Database Manager icon appears in the taskbar.

c. Right-click  or  or  in the taskbar and select Settings. The Metasys Database
Manager Monitoring Settings window appears.

Go to Choosing monitoring settings for information on choosing Monitoring settings.

Choosing monitoring settings
About this task:
For more information on the contents of the Monitoring Settings window, see Monitoring settings.

Note: The latest available version of the ODS is Release 10.1. The ODS is not available for
upgrade to Metasys Release 11.

Metasys Database Manager Help46



To set the Metasys Database Manager monitoring settings:

1. Access the monitoring settings. See Accessing/Starting monitoring settings.
Note: If the Settings selection or window is not visible, they may not be available to you
based on your Windows access rights or because you need to take special steps when you
open the window. See Required access rights and Accessing/Starting monitoring settings.

2. In the General section of the Monitoring Settings window (Figure 11), select how often you
would like the databases monitored.

3. If you would like to send email notification of status changes, enter the addresses to which
notification should be sent in the Email section.

4. To send a test email to the addresses you entered in Step 3, click Send Test Email.
5. In the Warning section, define the parameters for a Warning state. If the databases reach the

size that you set here, the taskbar icon changes to  and the Metasys Database Manager
sends an email to the addresses listed in the Email section (if you select Email on warning).

6. In the Alarm section, define the parameters for an Alarm state. If the databases reach the size

that you set here, the taskbar icon changes to  and the Metasys Database Manager sends
an email to the addresses listed in the Email section (if you select Email on alarm).

7. In the Database User Account section, enter your SQL Server software login credentials. If
you do not enter your credentials here, the Metasys Database Manager uses the credentials
used to log in to the ADS/ADX/ODS/OAS computer. See Database login.

8. Click OK.

Stopping database monitoring
About this task:
To stop database monitoring:

1. Right-click  or  or  in the taskbar and then click Exit. A confirmation box appears.
2. Click OK.

Note: The log creates an entry when you exit database monitoring. See Log file.

Viewing the log file
About this task:
To view the log file:

1. Right-click  or  or  in the taskbar and select View Log File. The Windows Event
Viewer opens.

2. On the left side of the viewer, select MetasysDBMonitor.
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Troubleshooting
Use Table 14 to troubleshoot the Metasys Database Manager.
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Table 14: Metasys Database Manager Troubleshooting
Problem Condition

The Metasys Database Manager
Monitoring Settings window
appears every time you restart
the ADS/ADX/ODS/OAS.

If you do not enter values in the Email section of the
Monitoring Settings window, the window appears every time
the ADS/ADX/ODS/OAS restarts.

To prevent the Monitoring Settings window from reappearing:

1. In the Email section of the Monitoring Settings window
(Figure 11), enter the correct information into the
appropriate fields. If you do not wish to use the Email
feature, enter at least three characters in the SMTP Server
field and in at least one address field.

2. Click OK.
You experience one or more of
the following:

• You cannot view all of the
tabs.

• You cannot access
monitoring settings.

This problem occurs when you do not have sufficient access
rights to use the Metasys Database Manager. See Required
access rights.
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Table 14: Metasys Database Manager Troubleshooting
Problem Condition

Metasys Database Manager does
not start, or the icon appears red,
indicating an alarm state. Other
users may log in to the same
computer and not experience
issues.

In some scenarios, only users without Windows administrator
privileges experience these issues.

If you experience this scenario, try the following:

1. Log in to the Windows OS as a user with administrator
privileges (not as a Standard user).

2. Right-click the Metasys Database Manager icon and
then click Exit.

3. Using Windows Explorer, browse to the following
location:
C:\ProgramData\Johnson Controls\MetasysIII
\MDM

4. Delete the following files:
JCIAuditTrails.txt
JCIEvents.txt
JCIHistorianDB.txt
JCIItemAnnotation.txt

5. Do not restart the Metasys Database Manager. Log out of
the OS.

6. Log in to the Windows OS as a user who does not have
administrative privileges (as a Standard user).

If the icon is still red, the Users group in the Windows OS
may not have public access to the Metasys databases. In this
scenario, do the following:

1. Using Add/Remove programs, uninstall the Metasys
Database Manager.

2. Reinstall the Metasys Database Manager.
Instead of granting the entire Users group public access to
the Metasys databases, you may prefer to grant access only to
some Windows users. If this is the case, grant public access to
the Metasys databases.
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Table 14: Metasys Database Manager Troubleshooting
Problem Condition

When a user logs on to their
Windows computer, the following
error message appears:
Metasys Database Manager.
Status: Alarm. There
was an error connecting
to the target database.
JCIHistorianDB. Metasys
Database Manager Monitor.

Change the permissions on the MDM folder and the files it
contains, complete the following steps:

1. Navigate to C:\ProgramData\Johnson Controls
\MetasysIII.

2. In the MetasysIII folder, right-click the MDM folder, and
click Properties.

3. Click the Security tab, and click Edit.
4. In the Group or user names area, click Users.
5. In the Permissions for Users area, in the Full control

entry, select Allow.
6. Click Apply.

A Database Error box appears:

At least one database
cannot be found. Make sure
your Metasys software has
been installed properly
and that SQL Server
service is running.

This error message appears if a timeout occurs when the
Metasys Database Manager attempts to connect to the
database. For example, the timeout may occur if the computer
is busy executing a virus scan.

This message also appears if the user credentials used to
connect to the SQL Server database do not have read access to
the databases. See Taskbar icon and Database login.

The Current Database Server
Connections field reads 0.

This may indicate that there are no connections to the SQL
Server software.

This field reads 0 if the Windows user account does not have
Administrator privileges.

While you monitor databases,
a message appears indicating
that one or more databases have
exceeded their allowed size.
However, you know the database
size is less than the alarm limit.

This message may appear if your SQL Server software access
credentials do not give you read access to the databases.

When you purge a database, the
database size seems to increase.

The log file may increase during a purge. The Metasys
Database Manager is working properly.

The JCIItemAnnotation database
does not grow. It is always the
same size.

The Annotation database is populated only on MVE systems.
(MVE is not currently supported on the ODS.) Event and audit
annotations are stored in the JCIEvents and JCIAuditTrails
databases.
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Table 14: Metasys Database Manager Troubleshooting
Problem Condition

After you restart a computer that
has Metasys Database Manager
installed, the icon in the Windows
system tray is red.

If the Metasys Database Manager comes online faster than one
of the managed SQL Server databases and cannot connect
to the managed database to determine the database size,
the Metasys Database Manager tray icon turns red, indicating
an alarm condition. As the size of the SQL Server databases
increases, the databases require more time to come online,
increasing the likelihood of encountering this alarm condition.
Although the SQL Server database size may suddenly seem
too large, the real cause of the alarm condition may be
that the Metasys Database Manager has not yet established
connections to the SQL Server databases.

The Metasys Database Manager connects with the SQL
Server and other associated databases at user-specified time
intervals. By the time of the next scheduled connection, the
SQL Server database completes the startup, the databases are
online, and the Metasys Database Manager icon turns green.

It is very unlikely that the SQL Server database has exceeded
the size limits during this time. A user who is concerned
about this possibility can restart Metasys Database Manager
immediately.

When the databases have finished coming online, the Metasys
Database Manager icon turns green. Until the databases have
finished coming online, the Metasys Database Manager icon
remains red. If the icon remains red after a restart, wait a few
minutes to allow the databases to finish coming online, and
restart the Metasys Database Manager.

You accidentally restore a
database over an existing
database.

If this occurs, you can restore the original database. The
Metasys Database Manager created a backup of the original
database before it was overwritten.

Automatic backups are stored in the Metasys Database
directory at C:\ProgramData\Johnson Controls
\MetasysIII\SQLData.

Backups use the following naming convention:

[yymmdd]FromRestore[databasename].bak

For example: 090605FromRestoreJCIHistorian.bak

To restore the original database, use the standard Metasys
Database Manager restoration procedure in Restoring a
database.
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Table 14: Metasys Database Manager Troubleshooting
Problem Condition
Metasys Database Manager does
not start, or the icon appears red,
indicating an alarm state. Other
users may log in to the same
computer and not experience
issues.

Update the folder permissions on C:\ProgramData\Johnson
Controls\MetasysIII\MDM to allow the Users group to write
to the directory.

Related documentation
Table 15 contains literature related to the Metasys Database Manager.

Note: The latest available version of the ODS is Release 10.1. The ODS is not available for
upgrade to Metasys Release 11.

Table 15: Metasys Database Manager Related Documentation
For Information On See Document
Installing the ADS/ADX Metasys Server Installation and Upgrade Guide (LIT-12012162)

Installing the ADS-Lite Metasys Server Lite Installation and Upgrade Instructions
(LIT-12012258)

Installing the ODS ODS Installation and Upgrade Guide (LIT-12011945)

Installing the OAS Open Application Server Installation and Upgrade Instructions
(LIT-12013222)

Installing the Metasys Database
Manager Metasys Database Manager Installation Guide (LIT-12011553)

Working with Trends, Alarms
(Events), Audits, and Annotations Metasys Site Management Portal Help (LIT-1201793)

Creating, Editing, and Loading
Archive Databases with the SCT Metasys SCT Help (LIT-12011964)

Product warranty
This product is covered by a limited warranty, details of which can be found at
www.johnsoncontrols.com/buildingswarranty.

Software terms
Use of the software that is in (or constitutes) this product, or access to the cloud, or hosted
services applicable to this product, if any, is subject to applicable end-user license, open-
source software information, and other terms set forth at www.johnsoncontrols.com/
techterms. Your use of this product constitutes an agreement to such terms.

Patents
Patents: https://jcipat.com

Contact information
Contact your local branch office: www.johnsoncontrols.com/locations
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Contact Johnson Controls: www.johnsoncontrols.com/contact-us

© 2020 Johnson Controls. All rights reserved. All specifications and other information shown were current as of document
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